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Raspoređivanje i štampanje crteža

Štampanje iz AutoCAD-a je komplikovanije nego iz 
drugih programa zašta postoje i sasvim određeni 
razlozi 
Tokom rada na projektu crteži se štampaju više puta a 
sve kopije treba da budu konzistentne 
Pošto je AutoCAD program za rad sa grafikom puno 
vremena se provodi na raspoređivanju objekata na 
papiru da bi sve bilo vizuelno dobro organizovano
Postoje dva različita aspekta štampanja: priprema 
finalnog izgleda na kartici Layout i štampanje crteža
Na kartici Layout može precizno da se organizuje crtež 
i da se ubace okvir crteža i tabela 
Ova kartica daje fleksibilnost u definisanju razmere i 
orijentisanju crteža na listu papira 
Na kraju može i da se pogleda kako će crtež tačno 
izgledati na papiru pre nego što se stvarno i odštampa



Ostale mogućnosti vezane za 
štampanje

Pored orijentacije i veličine papira AutoCAD ima više drugih 
mogućnosti vezanih za štampanje 
Mogu se upamtiti podešavanja štampača što kasnije pomaže 
da se lako reprodukuje ono što je jednom odštampano 
Pošto u AutoCAD-u postoje i neke napredne 3D mogućnosti sa 
2D crtežima mogu da se kombinuju 3D pogledi 
Mogu čak i da se ubace informacije o datoteci tako da se 
kasnije lako pronalazi izvor na osnovu kojeg je crtež 
odštampan
Osnovne teme, kada je u pitanju raspoređivanje i štampanje 
crteža su

podešavanje crteža za štampanje
štampanje crteža
zapisivanje podešavanja štampača
kontrola boja, linija i ispuna pomoću stilova za štampanje
dodeljivanje stilova za štampanje sa nazivima direktno nivoima i
objektima
prebacivanje crteža sa stilovima za štampu sa bojama u crteže sa
stilovima za štampu sa nazivima 



Podešavanje crteža za štampanje

U većini programa može da se izabere 
File->Print i crtež pošalje na štampač
Iako se to može uraditi i u AutoCAD-u 
najbolji način kontrole rezultata 
štampanja je da se na kartici Layout 
podesi izgled crteža za štampu
Pre samog štampanja treba da podesiti 
neke opcije
Na kartici Layout može da se precizno 
podesi crtež tako da na papiru izgleda 
onako kako se želi



Vežba
Otvoriti novi crtež i dodati nekoliko objekata, kao što su pravougaonici i 
krugovi, koji će se koristiti pri vežbanju funkcionisanja kartice Layout
Izabrati karticu Layout 
Objekti će biti prikazani u pravougaoniku, koji je unutar drugog
pravougaonika, kao što je prikazano na slici
Bela površina predstavlja papir na kome će crtež biti odštampan 
Crtež se nalazi na sivoj pozadini tako da se ispod belog prostora vidi 
siva senka 
Isprekidana linija ukazuje na deo papira na kome se ne može štampati
Pravougaonik sa punom linijom koji uokviruje crtež predstavlja prikaz 
koji je neka vrsta prozora u prostor modela



Osobine prikaza
Ovaj prikaz se ponaša kao i drugi objekti u 
AutoCAD-u zato što se može menjati pomoću palete 
Properties 
Može se podesiti nivo na kome se prikaz nalazi, tip 
linije i boja, a širina i visina se podešavaju pomoću 
čvorova
Prikaz crteža koji je napravljen na kartici Model ima 
osobine koje kontrolišu tačnu razmeru pogleda koji 
se u njemu prikazuje 
Mogu se koristiti komande Pan i Zoom tako da ne 
postoji ograničenje samo na jedan pogled
Izbor delova crteža klikom negde unutar crteža nije 
moguć zato što je trenutna pozicija u prostoru 
papira, mada postoje načini da se „uđe” u prikaz i 
da se pogled menja sa kartice Layout



Vežba
Kliknuti granicu prikaza, potom desnim tasterom 
miša iz menija sa prečicama izabrati Properties 
Ova paleta pokazuje da je prikaz kao i drugi objekti 
u AutoCAD-u, odnosno da ima svoj nivo, tip linije i 
dodeljenu boju 
Isključivanjem tog nivoa može da se sakrije granica 
prikaza
Zatvoriti paletu Properties i dok je prikaz još uvek 
izabran pritisnuti Delete ili izabrati alat Erase sa 
palete Modify  - pogled na crtež će nestati
Ovo pokazuje da je prikaz neka vrsta prozora u 
crtež koji je napravljen na kartici Model 
Kada se obriše prikaz i pogled na crtež nestaje sa 
njim



Vežba (nastavak)
Povratiti prikaz dugmetom Undo
Izabrati dugme Paper na statusnoj liniji, kao što je
prikazano na slici
Natpis na dugmetu se menja na Model i granica prikaza 
postaje tanja 
Kada se izabere dugme Paper, prelazi se u pokretni 
prostor modela, koji omogućava da se crtež uređuje 
unutar prikaza kao na kartici Model
U prikazu se vidi i UCS ikona: prikaz se ponaša kao 
minijaturna verzija kartica Modela 
To i jeste način na koji se ponaša pokretni prostor 
modela 
Može se shvatiti kao prečica do sadržaja kartice Model



Vežba
Izabrati neki od objekata nacrtanih na početku ove vežbe - sada 
se mogu birati objekti u prikazu
Probati zumiranje i pomeranje po crtežu - promene pogleda se 
dešavaju samo u okviru prikaza
Izabrati View->Zoom->All ili uneti Z<Enter> A<Enter> da bi se 
prikazao ceo crtež
Izabrati dugme Model na statusnoj liniji za povrtak u prostor 
papira 
Granica prikaza dobija originalnu debljinu a UCS ikona će nestati 
iz prikaza
U vežbi su pokazane neke jedinstvene karakteristike kartice 
Layout 
Objektima u prikazu se ne može pristupiti dok se ne uđe u 
pokretni prostor modela tako što se izabere dugme Paper sa 
statusne linije 
Na kartici Layout može se napraviti proizvoljno mnogo prikaza i u 
svakom od njih može biti drugačiji pogled na crtež 
Svakom prikazu se može zadati veličina i može se podesiti kako 
potrebe nalažu



SAVET

Ne postoje prepreke da se na kartici 
Layout crta i izvan prikaza 
Neki korisnici smatraju da je bolje dodati 
kote i napomene u prostoru papira, tako 
da notacija crteža ostane konzistentna 
kada postoji više prikaza 
Pored toga se tablice i okviri često dodaju 
na kartici Layout 
Ono što se nacrta u prostoru papira ne 
prikazuje se na kartici Model



Izbor veličine i orijentacije papira

Ako se AutoCAD pokreće prvi put i ako je 
reč o potpuno novom crtežu, 
podrazumeva se da se crtež štampa na 
papiru veličine 8½"x11" 
To je podrazumevana veličina papira koja 
je prikazana na kartici Layout 
Ako raspoloživi štampač može da štampa 
na većim formatima papira, treba podesiti 
da se prikazuju i druge veličine i 
orijentacije



Vežba

Izabrati File->Plot ili desnim 
tasterom miša izabrati 
karticu Layout na dnu 
prozora AutoCAD-a i izabrati 
opciju Plot 
Otvoriće se okvir za dijalog 
Plot koji je prikazan na slici 
gore
Iz grupe Printer/Plotter 
izabrati padajuću listu Name 
a onda štampač
Izabrati dugme More Options 
koje se nalazi u donjem
desnom uglu okvira za
dijalog - to je okruglo dugme
sa strelicom usmerenom
udesno (slika dole) 



Vežba (nastavak)

U grupi Drawing Orientation izabrati Landscape ili 
Portrait u donjem desnom uglu okvira za dijalog
Da bi se crtež štampao kao crno-beli a ne sa 
nijansama sive ili drugih boja iz liste Plot Style 
Table izabrati opciju monochrome.ctb (slika)



Vežba (nastavak)
Nakon potrebnih promena 
podešene vrednosti mogu da 
se upamte da bi se koristile 
na drugim karticama Layout, 
tako ne mora uvek iznova da 
se vrši podešavanje
Izabrati dugme Add na vrhu 
okvira za dijalog Plot (grupa 
Page Setup), kao što je 
prikazano na slici gore
U okviru za dijalog Add Page 
Setup uneti naziv tih 
podešavanja ili prihvatiti 
podrazumevani naziv koji 
nudi AutoCAD (slika dole)
Izabrati OK za povratak u 
okvir za dijalog Plot



Vežba (nastavak)
Izabrati dugme Apply To Layout na dnu okvira za 
dijalog da bi se upamtila urađena podešavanja
Izabrati Cancel da bi se napustio okvir za dijalog 
bez štampanja crteža
Po povratku na karticu Layout, pojavljuju se neke 
male razlike u isprekidanoj liniji koja prikazuje 
oblast na štampaču na kojoj se ne štampa 
Pošto je svaki štampač različit, ova oblast zavisi 
od konkretnog štampača
Pri narednom otvaranju okvira za dijalog Plot biće 
prikazane iste vrednosti koje su unete u 
prethodnom primeru 
Može da se izabe OK i nastavi štampanje



Smanjenje razmere crteža pomoću
kartice Layout

Na kartici Model se sve crta u punoj razmeri
Kada je crtež spreman za štampanje, potreban je 
način da se on smanji crtež tako da stane na 
traženi format 
Kartica Layout je mesto gde se može podesiti 
crtež iz prostora modela u skladu sa veličinom 
papira 
Može se izabrati neka od standardnih razmera, 
tako da crtež stane na izabrani papir 
Ako se ne zna razmera koja treba da se upotrebi, 
proba se nekoliko njih, dok se ne pronađe ona 
koja omogućava da crtež stane na papir 



Vežba
Podešavanje razmere 
prikaza na kartici 
Layout 
Na kartici Layout 
izabrati granicu 
prikaza, zatim desnim 
tasterom miša izabrati 
Properties
U paleti Properties 
izabrati opciji Standard 
Scale, koja se nalazi u 
kategoriji Misc i sa 
desne strane će biti 
prikazana lista, kao na 
slici



Vežba (nastavak)

Otvoriti listu i izabrati razmeru pa će pogled u 
prikazu biti promenjen u skladu sa novom 
razmerom
Zatvoriti paletu Properties
U polje Custom Scale može da se unese sopstveni 
faktor razmere, ako potrebna razmera ne postoji u 
listi standardnih razmera
Često postoji potreba da se na kartici Layout vidi 
nekoliko pogleda sa kartice Model 
Na primer, presek zida može da bude prikazan u 
jednoj razmeri i uvećani detalji u drugoj, a da se 
sve to vidi na kartici Layout



Dodavanje prikaza
Pomoću okvira za dijalog Viewports se može dodati proizvoljno mnogo prikaza 
Ako se želi samo jedan dodatni prikaz, treba uraditi sledeće:

Izabrati View- >Viewports- >New Viewport - otvoriće se okvir za dijalog Viewports
Iz liste Standard Viewport izabrati opciju Single (slika), potom OK
Po odzivu Specify first corner of [Fit] <Fit>: pokazati tačku u rasporedu gde treba 
da počne novi prikaz, a potom na odziv Specify opposite corner: drugo teme 
pravougaonika koji definiše prikaz
Veličina prikaza može i dalje da se podešava ako se izabere njegov okvir i promeni 
položaj čvora- ako prikaz treba da pokrije ceo raspored, može da se unese 
F<Enter> 
Ovim se poziva opcija Fit umesto zadavanja temena pravougaonika 



Dodavanje više prikaza odjednom

U okviru za dijalog Viewport postoji 
nekoliko opcija koje omogućavaju 
da se odjednom doda više prikaza
U drugom koraku iz prethodnog 
primera je izabrana opcija Single
Ako se izabere neka druga opcija, 
kao što je, na primer, Three:Above, 
u panou sa desne strane će se videti 
kako taj prikaz izgleda (slika)
U ovom panou se pokazuje kako ta 
opcija izgleda kada se postavi u 
prikaz
Kada se izabere opcija i klikne OK, 
prikaz može da se postavi na isti 
način kao u koracima iz prethodnog 
primera 
Može da se unese F<Enter> ako se 
želi da prikazi ispune ceo raspored



Druge opcije sa više prikaza (I)

Neke druge opcije omogućavaju kontrolu pogleda 
koji se prikazuju u svakom od prikaza
Podrazumevano se u svim prikazima postavlja 
tekući prostor modela
Može da se izabere prikaz sa prethodnim 
pregledom i da se onda izabere pogled iz liste 
Change View To, koja je prikazana na slici
Pre nego što ova opcija bude mogla da prikaže bilo 
šta osim Current mora se na kartici Model upamtiti 
pogled



Druge opcije sa više prikaza (II)

Druga opcija je padajuća lista Setup (slika)
Ona omogućava izabor 2D ili 3D pogleda
Ako se izabere 3D, u panou za prethodni 
pregled se prikazuju opcije top, bottom, side i 
isometric 
Padajuća lista Change View To može da se onda 
upotrebi za izbor tipa pogleda za svaki prikaz



Kontrola načina prikazivanja i 
štampanja prikaza

Postoji još nekoliko opcija koje omogućavaju kontrolisanje 
načina na koji se prikazi vide i štampaju 
Može u potpunosti da se isključi prikazivanje crteža, da se 
zaključa pogled tako da se spreče slučajna pomeranja i 
zumiranja ili da se podesi 3D pogled da štampa skrivene 
linije ili renderovani pogled
Može se desiti da se puno vremena provede u 
podešavanju pogleda u prikazu radi podešavanja razmere 
i oblasti koja se prikazuje, a da se kasnije slučajno 
promeni razmera 
Ovo se može desiti odlaskom u prostor modela i 
zumiranjem dela pogleda
Zbog toga, u AutoCAD-u postoji način da se pogled u 
prikazu zaključa tako da se ne može zumirati i pomerati u 
njemu, niti se može menjati razmera sadržaja pogleda



Vežba

Zaključati prikaz u odnosu na pomeranje i 
zumiranje: kliknuti okvir prikaza, desnim 
tasterom miša izabrati Display Locked-> 
Yes 
Nakon toga se alati pan i zoom mogu 
koristiti u tekućem prikazu, ali ne utiču na 
njegov pogled
Pogled uključiti i isključiti: izabrati granicu 
prikaza, desnim tasterom miša izabrati 
opciju Display Viewport Objects->Yes



Štampanje 3D modela sa skrivenim 
linijama ili senčenjem

Ako pogled u prikazu sadrži 3D model koji 
treba da se štampa sa skrivenim linijama 
ili senčenjem, treba izabrati granicu 
prikaza, potom Shaded Plots->Hidden ili 
Shaded Plots->Rendered 
Pogled na model se neće promeniti, ali će 
prilikom štampanja 3D model biti 
prikazan sa skrivenim linijama ili osenčen



Podešavanje nivoa za pojedinačne 
prikaze (I)

Na kartici Layout mogu da se kontrolišu 
nivoi za svaki prikaz 
Ovo je korisno ako isti pogled na crtež 
treba da se prikaže na različite načine 
Na primer, na kartici Model se može 
nacrtati plan sprata, pri čemu se različite 
informacije smeštaju na različite nivoe 
Nakon toga, na kartici Layout se napravi 
više prikaza koji prikazuju isti pogled, ali 
sa različitim nivoima, tako da se prikazuju 
različiti elementi 



Podešavanje nivoa za pojedinačne 
prikaze (II)

Ako se crta plan sprata, 
može jedan prikaz da bude 
sa nameštajem i drugi sa 
rasporedom električnih 
instalacija, a da tom prilikom 
bude isključen nivo sa 
nameštajem, kao na slici
Ikona Sunca na levoj strani 
može da "zamrzne" i 
"odmrzne" nivoe globalno
Nekoliko mesta dalje od nje 
je ikona Sunca sa providnim 
pravougaonikom
Ona kontroliše "zamrzavanje" 
i "odmrzavanje" nivoa za 
pojedine prikaze
U narednoj vežbi je pokazano 
kako ovo funkcioniše



Vežba
Otvoriti bilo koji ranije urađen crtež koji sadrži više 
nivoa 
Izabrati dugme Paper na statusnoj liniji za prelazak u 
pokretni prostor modela
Izabrati prikaz čije nivo se želi kontrolisati
Otvoriti okvir za dijalog Layer Properties Manager
Pronaći nivo koji će da se uključi ili isključiti i kliknuti 
njegov naziv (slika)



Vežba (nastavak)

Naći kolonu Current VP Freeze za izabrani nivo (možda treba 
proširiti okvir za dijalog Layer Properties Manager ili pomeriti
klizač na dnu da bi se videla ova kolona) 
Kolona Current VP Freeze je druga kolona sa desne strane: 
ikona izgleda kao providni pravougaonik iznad Sunca, koje 
ukazuje da je nivo za tekući prikaz uključen (slika)
Izabrati ikonu Current VP Freeze za isključenje nivoa u 
tekućem prikazu: sunce će preći u pahuljicu
Po završetku, izabrati OK 
Izabrani prikaz će biti promenjen u skladu sa onim što je 
promenjeno



Vežba (nastavak)
Za "zamrzavanje" nivoa u pojedinim prikazima može se koristiti i
padajuća lista Layer Control sa palete 
Ponoviti korake iz prethodnog primera ali umesto otvaranja okvira 
za dijalog Layer Properties Manager otvoriti padajuću listu Layer 
Control koja je prikazana na slici
Iz liste se može izabrati nivo koji se menja a onda kliknuti ikona 
Sunca sa malim pravougaonikom čime se isključuje nivo 
Ako se nivo u nekom prikazu ne vidi, a treba da se prikaže, uključi 
se ili "odmrzne" na globalnom nivou 
Ovo se radi pomoću kolona On/Off ili Freeze/Athaw u okviru za 
dijalog Layer Properties Manager



Dodavanje rasporeda

U novom crtežu podrazumevano 
postoje dve kartice Layout, pod 
nazivima Layout1 i Layout2, ali ne 
moraju da se koriste samo ova dva 
rasporeda
Za male projekte sa nekoliko crteža 
koji se štampaju može za svaki list 
da se podesi drugi raspored



Vežba
Desnim tasterom miša izabrati karticu Layout, koja treba da se kopira
Iz menija sa prečicama izabrati Move or Copy, što će otvoriti dijalog Move or 
Copy
Izabrati naziv rasporeda koji se kopira i uključiti opciju Create a Copy, koja 
se nalazi u donjem delu okvira za dijalog (slika)
Izabrati OK - pojaviće se nova kartica Layout
Na njoj je naziv originalne kartice, koja je kopirana - iza tog naziva se u 
zagradama nalazi broj, koji označava da je to kopija
Za promenu naziva nivoa, kliknuti desnim tasterom miša i iz menija sa 
prečicama izabrati opciju Rename 
Otvoriće se okvir za dijalog Rename Layout
Uneti novo ime i izabrati OK 
Nova kartica će imati ista podešavanja štampača kao i original



Štampanje
Štampanje crteža
AutoCAD podrazumevano štampa crtež onako kako on izgleda u 
prozoru AutoCAD-a, uključujući i boje koje su dodeljene 
objektima i nivoima 
Boje su korisne kod uređivanja, pošto mogu da pomognu da se 
vizuelno organizuje crtež, ali se crtež najčešće štampa u crno-
beloj tehnici 
Stilovi štampanja mogu da se koriste za automatsku konverziju 
boja u crnu ili nijanse sive 
Izbor i zapisivanje podešavanja štampača
Grupa Printer/Plotter omogućava izbor štampača i podešavanje 
opcija za izabrani štampač 
Na prvi pogled, ove opcije liče na one koje postoje u drugim 
programima koji rade pod Windows-om, ali ipak postoje bitne 
razlike
Promene opcija štampača mogu da se upamte i da se kasnije 
pozovu



Vežba
Izabrati File->Plot ili desnim tasterom miša izabrati karticu Layout 
na dnu prozora AutoCAD-a
Iz menija sa prečicama izabrati opciju Plot - otvoriće se okvir za 
dijalog Plot
Iz padajuće liste Name, koja se nalazi u grupi Printer/Plotter, 
izabrati štampač
Izabrati dugme Properties - otvoriće se okvir za dijalog Plotter 
Configuration Editor
Promeniti opcije po želji i potom OK - biće prikazan okvir za dijalog 
Changes to a Printer Configuration File koji je predstavljen na slici
Uneti naziv konfiguracije štampača, koji će podsećati čemu 
podešavanja služe, a onda OK



Datoteke za konfiguraciju

Kada se narednog puta pomoću liste Name izabere štampač biće 
prikazan naziv datoteke (sa konfiguracijom štampača koja je 
upravo napravljena) 
Tada se ona može izabrati za primenu upamćenih podešavanja, 
pa podešavanja koja su korišćena za štampanje crteža ne moraju 
da se pamte
Jedan štampač može da ima više datoteka za konfiguraciju
Konfiguracija može da se napravi za korisnički definisane veličine 
papira ili za neke druge opcije koje postoje u okviru za dijalog
Plotter Configuration Editor
Datoteke sa konfiguracijom imaju ekstenziju .PC3 
One se podrazumevano smeštaju u fascikli C:/Documents and 
Settings/Korisnicko ime/Application Data/Autodesk/AutoCAD 
2006/Ri6.l/enu 
Korisničko ime je ime pod kojim se korisnik prijavio na sistem 
Do ove fascikle se može brzo doći izborom File-> Plotter Manager



Opcije za podešavanje štampača (I)

Opcije za podešavanje 
štampača mogu biti 
različite za različite 
štampače 
Ipak, mogu se dati neke 
osnovne napomene o 
tome kako se koristi okvir 
za dijalog Plotter 
Configuration Editor 
Tu pripadaju opcije kao 
što su port na koji je 
štampač povezan, kvalitet 
štampanja bitmapa, 
korisničke veličine papira i 
kalibracija štampača 



Opcije za podešavanje štampača (II)

U okviru za dijalog Plotter Configuration Editor postoje tri 
kartice: General, Ports i Device and Document Settings 
Na kartici General se prikazuje lista drajvera za Windows, koje 
ta konfiguracija koristi (ako postoje) a tu je i prostor za 
komentare 
Na kartici Ports se definiše kuda se šalju podaci sa plotera 
Može da se izabere i opcija AutoSpool da bi se crtež prvo poslao 
na neku međulokaciju, dok se ne pošalje na odgovarajući izlazni 
uređaj 
Kartica Device And Document Settings je glavni deo ovog okvira 
za dijalog 
U glavnoj listi se nalaze opcije koje su poređane po hijerarhiji, 
slično kao stavke u Windows Exploreru
U listi postoje četiri glavne kategorije: Media, Graphics, Custom 
Properties i User Defined Paper Sizes & Calibration 
Nisu sve opcije dostupne za sve štampače - kada se iz liste 
izabere neka stavka, u delu ispod liste se prikazuju opcije koje
su "vezane" za tu stavku



Opcije za podešavanje štampača (III)

Media
Većina štampača ima mogućnost izbora veličine i izvora za 
medijum na kome se štampa, kao i izbor tipa tog 
medijuma 
Ako je na raspolaganju opcija Source and Size, opcija 
Media omogućava da se ona izabere
Opcija Duplex Printing, kada je na raspolaganju, 
omogućava dvostranu štampu
Graphics
Ove opcije kontrolišu dubinu boja, tačke po inču i 
renderovanje osenčenih oblasti 
Ovde može da se vrši podešavanje radi boljih boja ili 
bržeg štampanja
Jedna od popularnih opcija je Merge Control, koja 
kontroliše preklapanje linija koje se crtaju



Opcije za podešavanje štampača (IV)

Custom Properties
Ove opcije su iste kao one koje se mogu podešavati kada se 
štampaču pristupi korišćenjem menija Windows Start (Start-> 
Settings->Printer and Faxes ->, desni taster miša -> štampač 
koji se menja -> Properties) 
Osnovna razlika je u tome da se podešavanja koja se izvrše 
pomoću ove opcije smeštaju u datoteku za konfiguraciju 
štampača
User Defined Paper Sizes
Postoji nekoliko opcija koje su "vezane" za veličinu papira 
One se nalaze pod naslovom User Defined Paper Sizes 
Kod nekih štampača opcija Custom Paper Sizes omogućava i 
kreiranje veličina papira koje nisu standardne 
Druga slična opcija je Modify Standard Paper Size, koja 
omogućava menjanje standardne veličine papira 
Opcija Filter Paper Sizes je korisna kod printera koji imaju veliki 
broj veličina papira - izborom iz liste mogu da se ograniče veličine 
papira koje se prikazuju u okviru za dijalog Plot



Opcije za podešavanje štampača (V)

Kalibracija štampača
Još jedna opcija iz grupe User-defined paper Size je
Plotter Calibration
Ona je bitna pošto omogućava podešavanje odnosa širine 
i visine slike na odštampanoj strani
Ako štampač razvlači crtež u nekom smeru, možda treba 
da se kalibriše
Opcija Plotter Calibration omogućava podešavanje 
štampača tako da se dobija crtež pravilnih proporcija
Ako se izabere opcija Plotter Calibration, u donjem delu 
okvira za dijalog će biti prikazano dugme Calibrate Plotter
Izborom ovog dugmeta se pokreće “čarobnjak” Calibrate 
Plotter, u kom se prate instrukcije i fino podešava visina i 
širina onog što se štampa



Opcije za podešavanje štampača (VI)

Izbor veličine papira i broja kopija
Ove opcije su prilično očigledne 
Veličina papira može da se izabere iz liste Paper Size, a 
broj kopija se podešava u polju Number Of Copies 
Postoji jedna karakteristika opcije Paper Size koja nije tako 
očigledna
Primenom osobina tekućeg štampača mogu da se 
kontrolišu veličine papira koje se prikazuju
Određivanje pogleda koji se štampa
Postoji mogućnost izbora dela crteža koji se štampa
U grupi opcija Plot Area postoji padajuća lista WhatTo Plot
U listi postoji nekoliko opcija koje određuju koji pogled se 
šalje na štampač
Obično se štampa iz rasporeda, uz korišćenje opcije Layout
Ako se štampa iz prostora modela, treba izabrati i određeni 
pogled 



Ostale opcije

Ostale opcije nude druge načine za izbor oblasti koja se štampa
U tabeli su prikazane ove opcije i objašnjena je njihova tipična
upotreba
Opcija Scale iz grupe Plot Scale utiče na način kako se opcije 
prikazuju na odštampanom papiru 
Obično, ako se koristi opcija Layout, može da se koristi 
podrazumevana razmera 1:1, koja se bira iz grupe Plot Scale 
Za opcije Limits, Extents, Display i Window mora da se izračuna 
razmera, a ako razmera nije bitna, može da se upotrebi opcija 
Fit To Paper

Opcija Upotreba

Limits Postoji samo na kartici Model. Ona definiše ono što se štampa na osnovu granica crteža. Ovo 
je isti pogled koji se dobija na crtežu izborom View->Zoom->AII.

Layout Kao oblast za štampanje se koristi tekući raspored.

Extents Kao oblast za štampanje se koristi opseg crteža. Ovo je isti pogled koji se dobija izborom View-
>Zoom->Extents.

Display Kao oblast za štampanje koristi se ono što je trenutno prikazano na ekranu.

Window Bira se prozor koji određuje ono što se štampa. Okvir za dijalog će biti privremeno zatvoren, 
tako da mogu da se izaberu tačke.



Podešavanje lokacije odštampanog 
crteža

Pomoću opcija iz grupe Plot Offset može da se 
podesi položaj crteža na papiru 
Opcije X i Y omogućavaju podešavanje lokacije slike 
povećanjem vrednosti X i Y koordinata
Podrazumevane vrednosti od nula u X i Y pravcima 
označavaju donji levi ugao prostora na papiru na 
kome se može štampati
Takođe, može da se podesi da se kao koordinatni 
početak koristi ugao papira, a ne ugao prostora za 
štampanje 
Na kartici Plot And Publish u okviru za dijalog
Options (Tools->Options) postoje opcije Specify Plot 
Offset Relative To 
U grupi postoje dva radio dugmeta: Printable Area i 
Edge Of Paper



Podešavanje razmere štampanja

Ako se štampa sa kartice Layout, razmera može da se ostavi na
1:1 
Postoji i mogućnost da se promeni razmera pomoću opcija iz 
grupe Plot Scale 
Na primer, ako crtež teba da se odštampa sa polovinom veličine, 
iz liste Scale se bira opcija 1:2 
Ako se štampa 3D pogled sa kartice Model, koristi se opcija Fit To 
Paper
Uglavnom, razmera štampanja treba da se podešava samo ako 
se štampa iz prostora modela i ako se koristi neka od opcija iz 
tabele opcija koje nisu Layout 
Tada je neophodno proveriti da li je izabrana razmera takva da 
crtež može da stane na izabrani papir (izabran iz grupe Paper 
Size) 
Za proveru može da se koristi dugme Preview u donjem levom
uglu okvira za dijalog Plot



Izbor razmere

Razmera se podešava izborom neke od 
opcija iz padajuće liste Scale 
Odnosi razmere se pojavljuju u poljima za 
unos teksta inch= 
Ako se koriste metričke jedinice, u poljima 
za unos teksta stoji natpis mm=
Ako se koristi neka razmera koja nije u listi 
Scale, treba izabrati opciju Custom i uneti 
odgovarajuće vrednosti u poljima za unos 
teksta inch= ili mm=



Podešavanje debljine linije u skladu 
sa razmerom

AutoCAD omogućava da se na crtežu podesi i 
debljina linija 
Kada se crtež štampa sa kartice Layout, AutoCAD 
verno štampa izabrane debljine linija
Ako treba da se štampa upola manji pogled ili 
raspored, i debljine linija treba da se smanje na 
polovinu
Da bi se osiguralo da se menja i razmera debljine 
linija, treba uključiti opciju Scale Lineweights
U tom slučaju se razmera primenjuje i na debljine 
linija



Opcije za štampanje 3D pogleda

Kada se radi sa 3D modelima, oni se mogu 
posmatrati kao žičani modeli, sa skrivenim linijama 
ili sa osenčenim pogledima 
Žičani model prikazuje linije na modelu, kao da je 
model providan 
Pogledi sa skrivenim linijama daju realističniji pogled 
i sakrivaju one linije koje se ne vide 
Osenčeni pogledi dodaju još malo realizma, tako što 
se telu dodaje površina
Ove opcije modu da se primene pri štampi pomoću 
grupe opcija Shaded Viewport Options u okviru za 
dijalog Plot 
U ovoj grupi postoje tri glavne opcije: Lista Shade 
Plot, Lista Quality i Polje za unos teksta DPI (dots 
per inch - tačaka po inču)



SAVET
Ako grupa Shaded Viewport Options nije prikazana, treba izabrati
dugme More Options u donjem desnom uglu okvira za dijalog Plot 
Opcije Shade Plot u okviru za dijalog Plot ne mogu da se koriste
ako se štampa sa kartice Layout 
Ova vrednost tada se kontroliše na sledeći način: kada je okvir za 
dijalog Plot zatvoren, izabrati pogled koji sadrži 3D pogled 
Desnim tasterom miša iz menija sa prečicama izabrati Shaded 
Plots, a potom željenu opciju koja se primenjuje na prikaz 
Opcije su As Displayed, Wireframe, Hidden i Rendered
Opcija As Displayed štampa 3D pogled onako kako izgleda u 
prikazu 
Opcija Wireframe štampa 3D pogled kao žičani model 
Opcija Hidden štampa pogled sa uklonjenim skrivenim linijama 
Opcija Rendered renderuje 3D pogled pre štampanja



Grupa Plot Options (I)

Grupa Plot Options sadrži neke opšte vrednosti koje se koriste za 
kontrolu onog što se štampa
Plot In Background
Ako se štampa velika datoteka, a to može duže potrajati, ova 
opcija se može upotrebiti za štampanje u pozadini 
Za vreme dok AutoCAD štampa može da se nastavi sa radom
Plot Objed Lineweights
Ako je za objekat ili nivo podešena debljina linija, ova opcija 
štampa debljine linija onako kako su zadate
Plot With Plot Styles
Stilovi štampanja omogućavaju da se kontroliše način štampanja 
boja, debljina linija, ispune i temena linija 
Ova opcija može da se koristi za definisanje da li se koriste stilovi 
za štampanje
Plot Paperspace Last
Ako se štampa sa kartice Layout, ova opcija određuje da li se 
objekti u prostoru papira crtaju pre ili posle objekata iz prostora 
modela



Grupa Plot Options (II)

Hide Paperscape Objects
Pomoću menija sa prečicama ili palete Properties može se kontrolisati 
prikazivanje skrivenih linija 
U slučaju da je 3D model nacrtan na kartici Layout u prostoru papira, ova 
opcija štampa objekte iz prostora papira sa skrivenim linijama
Plot Stamp On
Pomoću ove opcije se može dodati žig na crtež 
Tu se štampaju informacije o tekućem crtežu koje mogu biti od koristi za 
nekoga ko gleda odštampanu kopiju 
Ako se aktivira ova opcija, pojaviće se dugme Plot Stamp Settings, kojim 
se otvara okvir za dijalog Plot Stamp 
U ovom okviru za dijalog mogu da se odrede informacije koje će biti 
odštampane 
Pomoću kartice Advanced se otvara okvir za dijalog Advanced Options u 
kome može da se definiše orijentacija i položaj tog žiga 
Tu mogu da se podese font i veličina teksta
Save Changes To Layout
Ako je ova opcija uključena, promene koje se izvrše u okviru za dijalog Plot 
zapisuju se sa tekućim rasporedom



Orijentacija crteža i zapisivanje
podešavanja štampača

Orijentacija crteža
Kao i kod većine programa, može se kontrolisati 
orijentacija dokumenta prilikom štampanja 
Ovde su tipične opcije Landscape, Portrait i Plot 
Upside Down
Zapisivanje podešavanja štampača
U grupi Page Setup na vrhu okvira za dijalog Plot 
otvara se lista sa podešavanjima koja su ranije
upamćena
Pomoću okvira za dijalog Page Setup Manager 
mogu da se prave podešavanja i da se njima 
upravlja
Otvaranje okvira za dijalog biće opisano u 
narednoj vežbi



Vežba
Izabrati File->Page Setup Manager ili desnim tasterom 
kliknuti karticu Layout i izabrati Page Setup Manager 
Otvoriće se okvir za dijalog Page Setup Manager, koji je 
prikazan na slici levo
Izabrati dugme New 
Otvoriće se okvir za dijalog New Page Setup, koji je 
prikazan na slici desno



Vežba (nastavak)
Za novo podešavanje štampača treba 
u polju New Page Setup Name uneti 
naziv, a onda izabrati prototip iz liste 
Start With, pa potvrditi sa OK 
Ponovo će se otvoriti okvir za dijalog 
Page Setup sličan okviru za dijalog 
Plot 
Neke od opcija ovde nisu na 
raspolaganju 
Kada se završe podešavanja potvrditi 
sa OK, za povratak u okvir za dijalog 
Page Setup Manager 
U listi Current Page Setup će biti 
prikazano novo podešavanje
Podešavanje može da se izabere iz 
liste a dugmetom Set Current se to 
podešavanje primenjuje na raspored 
Podešavanje može i da se izabere iz 
grupe Page Setup u okviru za dijalog 
Plot (slika)



Uvoz podešavanja

Podešavanja se čuvaju zajedno sa crtežom, ali se 
mogu uvoziti i iz drugih crteža pomoću opcije 
Import iz okvira za dijalog Page Setup Manager
Otvoriće se standardni okvir za dijalog za rad sa 
datotekama, odakle se bira datoteka sa 
podešavanjem koje je potrebno, pri čemu treba 
znati u kojem crtežu je to podešavanje upamćeno
Trenutno podešavanje se primenjuje na tekuću 
karticu Layout, ali kada se izvrši novo 
podešavanje, ono se kao opcija prikazuje u okviru 
za dijalog Plot Setup Manager i za druge 
rasporede



Kontrola linija, boja i ispuna pomoću 
stilova za štampanje (I)

Prilikom štampanja crteža AutoCAD 
pokušava da reprodukuje izgled crteža sa 
kartica Model ili Layout 
Ako treba da se promeni način na koji se 
neki delovi crteža štampaju, na primer, da 
se sve linije štampaju u crnoj, umesto u 
bojama koje su im dodeljene, ili da se 
ispune štampaju u nijansama sive, umesto 
u dodeljenim bojama, a da se ne menjaju 
objekti, moraju da se primene stilovi za 
štampanje



Kontrola linija, boja i ispuna pomoću 
stilova za štampanje (II)

Stil za štampanje se može posmatrati kao način za 
prevođenje boja i ispuna sa crteža u različite boje i 
šrafure 
Može se podesiti da se crvena boja štampa u crnoj ili 
sivoj, pa čak i zelenoj boji, ili da se površine obojene 
crnom bojom štampaju sa 30 odsto senke 
Stilovi za štampanje omogućavaju i da se definiše da li 
linije koje formiraju uglove pravougaonika treba da 
budu zaobljene ili sa oborenim krajem (slika)



Stilovi za štampanje
Postoje dva tipa stilova za štampanje 
To su stilovi sa bojama i sa nazivima 
Stilovi sa bojama omogućavaju kontrolisanje izlaza koji se 
štampa na bazi boja koje su dodeljene objektima na 
crtežu 
Na primer, može se reći da se crvena boja štampa kao 
crna i da se koristi 50 odsto boje sa ekrana ili kao linija 
debljine 0,5 mm 
Ovaj metod je sličan onom koji je korišćen u ranim 
verzijama AutoCAD-a, a ostao je do danas, uglavnom zato 
što postoji puno starih crteža koji koriste ovakve stilove
Stilovi sa nazivima rade na drugačiji način 
Oni omogućavaju da se skupu parametara za štampanje 
da naziv 
Ti parametri mogu biti debljina linija, boja, procenat boje 
sa ekrana ili način spajanja linija 



Unapred definisani stilovi za 
štampanje u AutoCAD-u

AutoCAD dolazi sa nizom stilova za štampanje koji su spremni za 
upotrebu 
Postoje dva skupa tih stilova 
Jedan se odnosi na stilove sa bojama, a drugi na stilove sa nazivima 
Stil za štampanje se bira iz padajuće liste Plot Style Table, koja se 
nalazi u okviru za dijalog Plot ili Page Setup (slika)
Većina onog što je potrebno može da se postigne sa standardnim 
stilovima za štampanje, a u ostalim slučajevima mora da se radi sa 
stilovima koji predstavljaju standard u projektantskom timu



Tabela unapred definisanih stilova 
za štampanje sa bojama

Stil za štampanje Namena

Acad.ctb Prilikom štampanja

DWF Virtual Pens.ctb  Konvertuje boje iz AutoCAD-a u virtuelna pera sa istim nazivom u DWF 
datotekama

Fill Patterns.ctb Konvertuje prvih devet boja iz AutoCAD-a u obrasce sa ispunom

Grayscale.ctb Konvertuje sve boje iz AutoCAD-a u ekvivalentne nijanse sive na štampačima 
koji podržavaju tu mogućnost

Monochrome.ctb Sve boje iz AutoCAD-a konvertuje u crnu

Screening xxx%.ctb Konvertuje sve boje iz AutoCAD-a u vrednosti na ekranu koje su određene 
imenom stila za štampanje (xxx je procenat smanjenja)

New Pokreće se “čarobnjak” Add Color Dependent Plot Style Table, koji omogućava 
da se napravi novi stil za štampanje



Tabela unapred definisanih stilova 
za štampanje sa nazivima

Stil za štampanje Namena

Acad. stb Boje iz AutoCAD-a se štampaju onako kako su prikazane na crtežu

Autodesk-Color.stb Uključuje smanjene boje u odnosu na pune (100 odsto) do 10 
procenata. Kao boju za štampanje koristi boju objekta

Autodesk-M0N0.stb Isto kao Autodesk-Color, ali boje konvertuje u crnu

Monochrome.stb Sve boje iz AutoCAD-a konvertuje u crnu.

New Pokreće se “čarobnjak” Add Name Dependent Plot Style Table, koji 
omogućava da se napravi novi stil za štampanje.



Da li izabrati stil za štampanje sa 
bojama ili nazivima?

Ako se prave sopstvene tabele stilova za štampanje, prvo se bira
tip stilova koji će se koristiti
Stilovi sa nazivima su fleksibilniji nego stilovi sa bojama, ali ako 
već postoji biblioteka crteža koji su podešeni za štampanje, bolje 
je izabrati stilove sa bojama 
Stilovi za štampanje sa bojama su najsličniji starom načinu rada, 
kada su boje iz AutoCAD-a dodeljivane perima na crtaču
Tip tabele stilova za štampanje koji je dodeljen crtežu zavisi od 
šablona koji je korišćen za pokretanje novog crteža 
Šablon acad.dwt koristi stilove za štampanje sa bojama, a šablon
acad - named Plot Styles.dwt koristi stilove sa nazivima
Moguće je podesiti da li će AutoCAD koristiti stilove za štampanje 
sa bojama ili nazivima kod novih crteža
U okviru za dijalog Options može se podesiti da se koristi 
podrazumevani stil za štampanje za crtež drawingx.dwg (x je broj
crteža) što će biti opisano u narednoj vežbi



Vežba

Izabrati Tools->Options 
Otvoriće se okvir za dijalog Options 
Izabrati karticu Plot And Publish
Izabrati dugme Plot Style Table Settings
Otvoriće se okvir za dijalog Plot Stvle Table Settings
U grupi dugmadi Default Plot Style Behavior For New 
Drawings izabrati radio dugme Color Dependent Plot 
Stvles
Potvrditi OK, pa još jednom Ok za povratak na crtež
Kada se podesi da AutoCAD koristi stilove za štampanje sa 
bojama, svi novi crteži će koristiti samo takve stilove 
Ovo se može u bilo kom trenutku promeniti za nove 
datoteke, ali kada se datoteka upamti, tip stila za 
štampanje koji je bio tekući u trenutku kreiranja datoteke 
je jedini tip koji u toj datoteci može da se koristi 



Kreiranje tabele sa stilom za 
štampanje

Ako se koristi stil za štampanje sa bojama, mogu 
da se naprave različite datoteke sa stilovima 
(datoteke sa ekstenzijom .ctb) za različite stilove 
crteža 
Jedan stil može da se napravi za crteže koji se 
koriste za prezentaciju 
Kod tog stila su bojama sa crteža dodeljene 
određene boje i ispune na ekranu
Mogu da postoje i određena podešavanja 
zatamnjenja koja se koriste kod jednobojnih crteža 
Postupak pravljenja sopstvenog stila za štampanje 
sa bojama je opisan u narednoj vežbi



Vežba

Otvoriti crtež, a onda izabrati karticu Layout 1
Desnim tasterom miša izabrati Page Setup Manager, potom izabrati 
Modify
U grupi dugmadi Plot Style Table otvoriti padajuću listu i izabrati 
New 
Ako se u tekućem crtežu koristi stil za štampanje sa bojama, onda 
će tu biti i opcija Add Color-Dependent Plot Style Table 
Ako se koristi stil za štampanje sa nazivima, onda će biti prikazan 
“čarobnjak” Add Name-Dependent Plot Style Table, kao na slici
Izabrati dugme Start From Scratch, a onda Next



Vežba (nastavak)

Na sledećem ekranu "čarobnjaka” će biti 
zatražen naziv datoteke, kao i izbor da li novi 
stil treba da bude podrazumevani za sve nove 
crteže ili da se primeni samo na tekući crtež 
Uneti naziv datoteke i izabrati Next
Naredni ekran "čarobnjaka” omogućava da se 
uredi stil i dodeli novim, tekućim ili starim 
crtežima 
Izabrati Finish za povratak u okvir za dijalog 
Page Setup 
Kada je napravljen stil za štampanje sa bojama, 
može da se ide dalje i podešavaju promene
U okviru za dijalog Page Setup otvoriti listu Plot 
Style i izabrati novi stil koji se uređuje
Izabrati dugme Edit 
Otvoriće se okvir za dijalog Plot Style Table 
Editor 
Dugme Edit se nalazi sa desne strane padajuće 
liste Plot Stvle Table 
Izabrati karticu Form View, koja je prikazana na 
slici



SAVET
Datoteke sa stilovima za štampanje nalaze se u 
fascikli: C:/Documents and Settings/Korisnicko 
ime /Application Data/Autodesk/AutoCAD 
2005/R16.1/enu/Plot Styles, gde je korisničko 
ime ono pod kojim se korisnik prijavio na sistem
Mogu se menjati izborom datoteke koja treba da 
se menja (dvoklikom) 
U okviru za dijalog Plot Style Table Editor postoje 
tri kartice koje omogućavaju kontrolisanje kako 
se štampa svaka od boja iz AutoCAD-a 
Na kartici Form View može da se izabere boja iz 
liste i da se onda podese osobine te boje pomoću 
opcija sa desne strane kartice



Opcije u okviru za dijalog Plot Style 
Table Editor

Kada se otvori okvir za dijalog Plot Style Table 
Editor, biće prikazano nekoliko opcija 
Ove opcije su iste i za stilove sa bojama i za 
stilove sa nazivima
Osnovna razlika je u tome da se kod stilova sa 
bojama u listi stilova nalazi svih 256 boja
Stilovi za štampanje sa nazivima imaju listu sa 
samo jednim stilom 
Mogu da se dodaju drugi stilovi i da im se daju 
nazivi



Kartica General

Na kartici General se nalaze informacije koje se 
odnose na stil za štampanje koji se trenutno 
uređuje 
U polju Description može da se unese opis stila 
U grupi File Information nalaze se osnovne 
informacije o lokaciji i nazivu datoteke i broju 
stilova sa bojama koji su uključeni u tabelu
Polje za potvrdu Apply Global Scale Factor To Non-
ISO Linetypes omogućava definisanje da li se ISO 
faktor razmera tipova linija primenjuje na sve 
tipove linija 
Ako je ovo polje potvrđeno, polje Scale Factor 
postaje aktivno, tako da može da se unese faktor 
razmere



Kartica Table View
Na kartici Table View nalaze 
se iste opcije kao na kartici 
Form View, jedina razlika je 
u formatu (slika) 
Svaki stil za štampanje je 
prikazan kao kolona sa 
osobinama koje su ispisane 
sa leve strane kartice 
Promena neke osobine se 
bira u koloni
Ista vrednost na sve stilove 
za štampanje se primenjuje 
desnim tasterom miša i 
izborom željene opcije (iz 
jednog stila), a onda iz 
menija Copy, dalje desnim 
tasterom miša, pa se iz 
menija bira Apply To All 
Styles



Kartica Form View

Za promenu osobine stila za štampanje ili 
boje, bira se stil iz liste sa leve strane a u 
grupi Properties sa desne strane se 
menjaju parametri
Na primer, ako se želi promena vrednosti 
smanjenja za stil Color 3, izabrati Color 3 iz 
liste Plot Style, dvoklik na polje Screening i 
unese se nova vrednost 
Može i odjednom da se izabere nekoliko 
stilova za štampanje



Opcije kartice Form View (I)

Description opcija omogućava unos opisa za svaku 
pojedinačnu boju 
Dither [Enable Dithering] opcija omogućava da 
štampač simulira boje izvan opsega od 256 boja koje 
postoje u AutoCAD-u 
Iako je ova opcija poželjna kada se želi štampanje sa 
većim opsegom boja, ona može dovesti do razlivanja, 
uključujući i prekinute linije i pogrešne boje
Zbog toga je ova opcija obično isključena
Ona ne postoji za sve štampače
[Convert to]Grayscale opcija konvertuje boje u nijanse 
sive
[Use Assigned] Pen# opcija omogućava zadavanje 
broja pera koji se dodeljuje bojama sa crteža
Primenjuje se samo kod crtača sa perima



Opcije kartice Form View (II)

Virtual Pen #
Mnogi inkjet i laserski štampači imaju opciju virtuelnih 
pera, kojom simuliraju proces rada starih štampača sa 
perima
Takvi štampači obično imaju 255 virtuelnih pera
Štampači sa virtuelnim perima često omogućavaju da se 
bojama iz AutoCAD-a dodeli broj virtuelnog pera
Ovo je bitno ako se virtuelna pera mogu dodeliti debljini 
štampanja, stilu završetka i stilu spajanja
U tom slučaju, virtuelna pera mogu da se koriste umesto 
opcija iz okvira za dijalog Plot Style Table Editor
Ova opcija ima najviše smisla kod korisnika koji već imaju 
puno crteža podešenih da rade sa virtuelnim perima



Opcije kartice Form View (III)

[Linetype] opcija se koristi za kontrolu tipa linija, na bazi 
boje objekta 
Podrazumevano je ova opcija podešena na Use Object 
Linetype i preporučuje se da se zadrži podrazumevanu 
vrednost
Adaptive [Adjustment] opcija kontroliše način na koji 
se linije sa tipom koji nije puna linija završavaju i počinju
Opcija je podrazumevano uključena, što znači da linije 
počinju i završavaju se linijskim segmentom
Ako je opcija isključena, onda se crta isti tip linije, bez 
obzira na kraj
U nekim slučajevima to može da dovede do toga da linija 
izgleda nekompletna
Line End Style opcija omogućava zadavanje oblika kraja 
jednostavnih linija, kod kojih je debljina linija veća od nule



Dodatne opcije

Line Join Style opcija 
omogućava određivanje oblika 
uglova polilinija (slika gore)
Fill Style opcija omogućava 
podešavanje boje koja se koristi 
kao obrazac, ako je reč o punim 
ispunama 
Obrazac se prikazuje u padajućoj 
listi, kao što je prikazano na slici 
dole
Add Style omogućava dodavanje 
novih stilova ili boja
Delete Style briše izabrani stil 
Save As omogućava snimanje 
tekuće tabele stilova



Dodeljivanje stilova za štampanje 
objektima

Kada se podese stilovi za štampanje sa nazivima, mogu da se 
dodeljuju objektima pomoću palete Properties
Vežba
Dodeliti stil za štampanje rasporedu na crtežu: 
File->Page Setup Manager->Modify
U okviru za dijalog Page Setup izabrati tabelu sa stilovima za 
štampanje (iz padajuće liste Name, koja se nalazi u grupi Plot Style 
Table) 
Proveriti da li je potvrđeno polje Display Plot Styles, potvrditi sa OK
Izabrati Close za zatvaranje dijaloga Page Setup Manager 
Nakon izbora tabele sa stilovima za štampanje, stilovi se mogu 
dodeliti objektima
Izabrati Format->Lineweight i proveriti da li je polje Display 
Lineweight potvrđeno. 
Podesiti pogled da se vidi donji levi ugao
Na statusnoj liniji, izabrati dugme Paper za prelazak u pokretni
prostor modela, gde mogu da se biraju objekti sa crteža, a da se
ostane na kartici Layout (slika)



Vežba (nastavak)
Izabrati objekte kojima 
se dodeljuje stil za 
štampanje, sa palete 
Properties izabrati 
opciju Plot Style 
(padajuća listu, slika 
gore levo) 
Izabrati tu strelicu i iz 
liste izabrati opciju 
Other 
Otvoriće se okvir za 
dijalog Select Plot 
Style, koji je prikazan 
na slici dole desno na 
kom se bira stil



Vežba (nastavak)
Izabrati View->Regen All 
Ako je uključeno prikazivanje debljine linija, rezultat 
će se videti u Drawing Editoru 
Stilovi za štampanje mogu da se dodeljuju i pomoću 
padajuće liste Plot Style Control, kao što je prikazano 
na slici 
Izabrati objekte, a onda iz liste Plot Style Control stil 
za štampanje 
Ovo omogućava da se stil za štampanje bira na sličan 
način kao nivoi iz liste Layer & Linetype
Ako se koriste stilovi za štampanje sa bojama, lista 
Plot Style Control nije na raspolaganju



Dodeljivanje stilova za štampanje sa 
nazivima direktno nivoima i objektima

Stilovi za štampanje sa nazivima se 
mogu dodeljivati i nivoima, slično kao 
stilovi za štampanje sa bojama
Osnovna razlika je što se kod stilova sa 
nazivima tabela stilova dodeljuje direktno 
nivoima, a ne boji nivoa 
U sledećoj vežbi se tabela stilova za 
štampanje dodeljuje nivou



Vežba

Izabrati Format-> 
Layers ili alat Layer 
Properties Manager 
(slika gore) da se 
otvori dijalog Layer 
Properties Manager
Izabrati nivo ili skup 
nivoa za koje se menja 
stil za štampanje 
U koloni Plot Style za te 
nivoe izabrati Normal 
(slika dole) 



Vežba (nastavak)

Otvoriće se okvir za dijalog 
Select Plot Style, kao što se 
vidi na slici
Iz liste Plot Styles izabrati stil 
za štampanje koji se 
dodeljuje nivoima, pa 
potvrditi OK 
Ponovo će se otvoriti okvir za 
dijalog Layer Properties 
Manager
Zatvoriti dijalog Layer 
Properties Manager, a onda 
izabrati View->Regen All
Pogled će biti promenjen 
tako da se vide promene 
nastale dodavanjem stila za 
štampanje nivoima



Prebacivanje crteža sa stilovima za štampu sa 
bojama u crteže sa stilovima za štampu sa 
nazivima

Ako treba da se prebaci crtež sa stilom za 
štampanje sa bojama u crtež sa stilom za 
štampanje sa nazivima, koriste se komande 
Convertctb i ConvertpStyles 
Konverzija je proces koji se odvija u dva 
dela 
U prvom delu, koji je potreban samo kada 
se prvi put obavlja konverzija, prebacuje se 
datoteka sa tabelom stilova za štampu sa 
bojama u datoteku sa tabelom stilova za 
štampanje sa nazivima 
Nakon toga, konvertuje se i crtež



Vežba

Otvoriti AutoCAD-ov crtež koji se prebacuje
Na komandnoj liniji uneti Convertctb  
Otvoriće se okvir za dijalog Select File u kome se bira 
datoteka sa tabelom stilova za štampanje sa bojama 
(ekstenzija .ctb)
Izabrati stil za štampanje sa bojama koji treba da se 
konvertuje a onda izabrati Open 
U dijalogu Create File dati naziv konvertovanoj datoteci 
Na primer, ako je u koraku 1 otvorena datoteka Acad.ctb, 
može se dati naziv AcadConvert, tako da se zna da je 
konvertovana ctb datoteka 
AutoCAD automatski dodaje ekstenziju .stb
Posle izvršavanja komande Save će biti napravljena nova 
datoteka sa tabelom stilova za štampanje sa nazivima



Vežba (nastavak)

Nakon konvertovanja tabele sa stilovima za štampanje, može da 
se konvertuje crtež: otvoriti datoteku koju se konvertuje i na 
komandnoj liniji uneti ConvertpStyles 
Biće prikazano upozorenje da će se konvertovati .ctb u .stb 
datoteku 
Nakon potvrde OK, otvoriće se dijalog Select File
Izabrati konvertovanu .stb datoteku napravljenu pomoću
komande Convertctb
Tekući crtež se konvertuje tako da koristi tabelu stilova za
štampanje sa nazivima
Proces konverzije crteža koji koristi stilove za štampanje sa 
nazivima u crtež koji koristi stilove za štampanje sa bojama je 
jednostavniji
Potrebno je da se pozove samo komanda ConvertpStyles
Nakon toga se prikazuje poruka da će svi stilovi za štampanje sa
nazivima biti obrisani sa crteža
Izabrati OK da bi se konvertovao crtež



GIS tehnologija
Geografski informacioni sistemi (GIS) su računarski sistem 
namenjeni prikupljanju, obradi, upravljanju, analizi, prikazivanju i 
održavanju prostorno orijentisanih informacija, odnosno 
informacija o geografskim entitetima 
GIS sadrži informacije kao što su mape i globusi, geografski 
skupovi podataka, modeli toka procesiranja rada, modeli 
podataka i metapodataka 
GIS može da se koristi u različite svrhe, odnosno da pruža 
odgovore na razne vrste specifičnih pitanja dozvoljavajući pri 
tome korisnicima da dobijene informacije podele sa drugima 
Vizualizacija odnosa, veza i modela podataka pruža nove 
mogućnosti za donošenje odluka zasnovanih na informacijama 
koje GIS sadrži, čime se povećava efikasnost poslovanja
GIS tehnologija se konstantno razvija kako bi izlazila u susret 
zahtevima koji dolaze iz prakse, odnosno industrije, uprave i 
obrazovanja, a koji se neprekidno menjaju. 
Najpoznatija kompanija za primenu GIS tehnologije je ESRI a 
distributer ESRI softvera kod nas je Geomatics



GIS – Inteligentan geografski sistem

Tokom istorije ljudu su 
izražavali i razmenjivali znanje 
kroz mnoge apstraktne forme, 
kao što su tekst, hijeroglifi, 
matematika, muzika i 
umetnost, crteži, slike i mape 
Sve ovo koritile su različite 
kulture i civilizacije kako bi se 
znanje prenosilo iz generacije u 
generaciju.
Ljudi su koristili različite 
apstraktne forme da bi 
prenosili i izražavali svoje 
zajedničke predstave o Zemlji i 
njenim sistemima 
Geografija daje univerzalan 
okvir za apstrakciju i 
komunikaciju kada je u pitanju 
mesto, odnosno prostor (slika)



Digitalizacija

U novije vreme znanja 
se sve više beleže u 
digitalnoj formi, pomoću 
računara, i razmenjuju 
putem mreža kao što je 
World Wide Web (slika) 
Znanja iz različitih 
oblasti velikom brzinom 
postaju digitalizovana, 
što je dovelo i do 
razvoja GIS koji 
omogućavaju da se bolje 
razumeju, predstave, i 
prenose mnogi aspekti 
Zemlje kao sistema 



Pet elemenata GIS-a
Geografija već vekovima predstavlja sistemski okvir 
koji obezbeđuje apstraktne forme za organizovanje i 
prenošenje ključnih znanja o prostornim entitetima 
GIS pruža relativno nov mehanizam za smeštanje 
geografskih znanja u pet osnovnih elemenata: mape i 
globusi, geografski skupovi podataka, radni modeli 
toka, modeli podataka i metapodaci
Ovih pet elemenata zajedno sa obimnom softverskom 
logikom GIS-a, formiraju blokove za sklapanje 
inteligentnih geografskih sistema 
GIS daje mogućnost da se geografska znanja 
obuhvate u digitalnoj formi 
Elementi GIS-a pružaju osnovu da se savladaju mnogi 
izazovi, kao što su, na primer, poboljšanje 
efikasnosti, inteligentno donošenje odluka na osnovu 
prostornih informacija i sl. 



Blokovi za izgradnju GIS-a

GIS geografiju svodi na 
apstraktnu formu 
pomoću pet osnovnih 
elemenata koji se 
koriste za prikazivanje 
geografskih znanja 
Ovi elementi, zajedno 
sa naprednim 
softverom, 
predstavljaju blokove 
za izgradnju GIS-a 
(slika)



Mogućnosti GIS-a

GIS pruža mogućnost formulisanja i razmene 
geografskih znanja u mnogim formama, kao što 
su napredni GIS skupovi podataka, mape, modeli 
podataka, procene stručnjaka koji su napravili 
standardizovane radne procese i modele 
geografskih procesa 
GIS daje mogućnost formiranja i upravljanja 
prostornim informacijama, koje mogu biti 
publikovane i distribuirane drugim korisnicima 
ArcGIS i geo-baze podataka su konstruisane da 
podrže pristup zasnovan na prostornim 
informacijama 
Oni omogućavaju kreiranje, korišćenje i deljenje 
svih elemenata prostornih informacija



Tri vida GIS-a
GIS podržava nekoliko vidova rada sa geografskim informacijama 
Geo-baza podataka
GIS je sveobuhvatna baza podataka koja sadrži skupove podataka
koji predstavljaju geografske informacije u formi generičkog GIS 
modela podataka koji čine: vektorski objekti (tačke, linije, 
poligoni) , rasteri, topologije, mreže, itd. 
Geovizualizacija
GIS je skup inteligentnih mapa i drugih formi za prikazivanje
karakteristika zemljine površine i njihovih odnosa
Pomoću GIS-a se mogu konstruisati mape koje prikazuju različite
slojeve geografskih informacija
Ove mape, odnosno slojevi se dalje mogu koristiti kao "prozori u 
bazu podataka" koji podržavaju pronalaženje, analizu i ažuriranje
informacija
Geoprocesiranje
GIS je skup alata za transformaciju informacija koji iz postojećih
skupova podataka izvodi nove
Ove funkcije geoprocesiranja primenjuju analitičke funkcije na
postojeće skupove podataka i rezultate zapisuju u novofprmirane
skupove podataka



Predstavljanje tri vida GIS-a u ArcGIS-u

Ova tri vida GIS-a su 
predstavljena u ArcGIS-u 
kroz:
katalog (GIS kao kolekcija 
geografskih skupova 
podataka)
mapu (GIS kao inteligentan 
prikaz podataka pomoću 
interaktivne mape)
alate ( GIS kao niz alata za 
geoprocesiranje) 
Sva tri elementa su ključni 
delovi GIS-a i koriste se na 
različitim nivoima u svim 
GIS aplikacijama (slika)



Distribuirani GIS

U današnje vreme slojevi (layer) i tabele 
podataka u većini informacionih sistema 
potiču iz više različitih organizacija 
Svaka GIS organizacija po pravilu razvija 
samo jedan deo sadržaja svojih podataka, 
odnosno bar jedan od slojeva podataka 
ima izvor van te organizacije 
Potreba za deljenjem GIS podataka navodi 
korisnike da preuzimaju podatke, pa čak i 
delove svojih baza podataka, od drugih 
GIS korisnika
Na taj način upravljanje GIS podacima je 
distribuirano među mnogim korisnicima 



Interoperabilnost

Distribuirana priroda GIS-a utiče na međusobnu 
saradnju mnogih GIS organizacija i sistema koja 
je veoma značajna 
Korisnici GIS-a se već dugo oslanjaju na 
međusobnu saradnju, a ta potreba se odražava i 
u novim naporima za standardizacijom GIS-a 
Oslanjanje na industrijske standarde i pravila 
GIS-a koja su prihvaćena kroz praksu su od 
velikog značaja za dalji razvoj ove oblasti 
GIS mora da podrži postojeće standarde i da 
bude sposoban da se razvija i prilagođava novim 
standardima koji će se pojavljivati



GIS mreže

Mnogi skupovi geografskih podataka mogu se sakupiti i njima 
se može upravljati kao generičkim izvorom informacija koji 
među sobom mogu deliti korisnici iz određene zajednice 
GIS korisnici kao sredstvo za deljenje često korišćenih 
podataka danas najviše koriste World Wide Web
Web čvorovi koji se nazivaju portalima GIS kataloga, mogu se 
koristiti za registraciju GIS korisnika ali i za pristup i korišćenje 
geografskih informacija 
Iz toga proizilazi sve veća povezanost GIS sistema kroz Web u 
cilju deljenja informacija 
Ova vizija postoji više od decenije i formalizovana je kao 
Infrastruktura prostornih podataka - Spatial Data 
Infrastructure (SDI), i to na nacionalnom nivou kao  National 
Spatial Data Infrastructure (NSDI), odnosno na globalnom 
nivou kao Global Spatial Data Infrastructure (GSDI) 
SDI koncept je danas u upotrebi ne samo na nacionalnom i 
globalnom nivou nego i u okviru država i lokalnih zajednica 



GIS mreža je jedna implementacija 
SDI-a

Veliki broj korisničkih sajtova publikuje, otkriva i koristi 
zajedničke - deljene, geografske informacije na  World 
Wide Web-u, odnosno geografsko znanje koje je 
distribuirano i slobodno integrisano 
Retko se sve neophodne informacije nalaze u jednoj 
bazi podataka sa jednim jedinstvenim obrazcem 
Na slici su prikazane GIS mreže i njihova komunikacija



Elementi GIS mreže
GIS korisnici računaju jedni na 
druge za pojedine vrste 
podataka, pri čemu GIS mreže 
daju mogućnost korisnicima da 
se povežu i podele svoje 
geografsko znanje 
GIS mreža ima tri ključna 
strukturna elementa (slika):
Portale kataloga 
metapodataka, gde korisnici 
mogu da traže informacije koje 
su za njih relevantne 
GIS čvorove, u kojima korisnici 
prikupljaju i publikuju skupove 
informacija 
GIS korisnike koji traže, 
nalaze, povezuju se i koriste 
GIS podatke i usluge



GIS portal - katalog

Važna komponenta svake GIS mreže je GIS portal - katalog sa 
registrom velikog broja skupova podataka i informacija 
Brojni GIS korisnici sakupljaju i publikuju svoje skupove 
podataka za deljenje, odnosno zajedničku upotrebu sa drugim 
organizacijama 
Oni registruju svoje informacije u katalog portala
Pretraživanjem ovog kataloga ostali GIS korisnici mogu pronaći 
željene informacije i povezati se sa njima
GIS portal - katalog je Web sajt na kome korisnici mogu tražiti i 
naći GIS informacije koje su im potrebne i koje se oslanjaju na 
mreže publikovanih GIS servisa podataka, karata i 
metapodataka 
Periodično GIS portal - katalog može prikupiti kataloge iz 
kolekcije korisničkih sajtova i objaviti jedan centralni GIS katalog 
Na taj način, GIS katalog se može odnositi na podatke sadržane 
na sopstvenom sajtu ali isto tako i na podatke sa drugih sajtova
Predviđa se da će u perspektivi biti dostupan niz ovakvih 
kataloga koji će formirati mrežu - SDI 



Korišćenje portala
GIS podaci i servisi su dokumentovani u katalogu 
podataka u GIS portalu koji se može pretražiti u cilju 
nalaženja podataka - kandidata za upotrebu u raznim 
aplikacijama (slika)



Inspire geo-portal
Jedan primer GIS portala je 
Inspire geo-portal 
organizovan na nivou 
Evropske Unije (http://eu-
geoportal.jrc.it/) 
Ovaj portal će pristup 
geografskim informacijama 
učiniti lakšim, bržim i 
efikasnijim za sve nivoe 
uprave i za javnost u 
Evropskoj uniji 
Na slici 10.44 je prikazan 
ovaj portal, koji predstavlja 
čvor u SDI-u EU



Razvoj GIS-a (I)
U ranim fazama razvoja GIS tehnologije, stručnjaci su se pre 
svega koncentrisali na prikupljanje podataka, aplikacije i 
projekte, provodeći veći deo vremena u pravljenju baze podataka 
i formiranju geografskog sadržaja 
Postepeno su ove kolekcije geografskih informacija počele da se 
koriste u brojnim GIS aplikacijama 
Korisnici su počeli da primenjuju višenamenske GIS radne stanice
za prikupljanje skupova geografskih podataka, izradu radnih 
modela za kompilaciju i kontrolu kvaliteta, kreiranje karata i 
analitičkih modela kao i dokumentovanje svog rada i metoda
Ovo je tradicionalni vid korišćenja GIS-a unapredilo u korišćenje 
putem profesionalnih radnih stanica koje su povezane sa 
skupovima i bazama podataka 
Radna stanica sadrži sveobuhvatne GIS aplikacije sa naprednom 
GIS logikom i alatima za izvršavanje praktično svakog GIS 
zadatka



Razvoj GIS-a (II)

Ovakav koncept pokazao se od neprocenjive koristi i široko je prihvaćen od 
strane GIS profesionalaca iz skoro 200,000 organizacija širom sveta 
U stvari, model klijent-server se pokazao tako uspešnim da mnogi danas 
posmatraju GIS isključivo u ovakvom kontekstu 
No ne treba gubiti iz vida da se vizija GIS-a i dalje proširuje
Savremen razvoj računarstva i informatike - rast Interneta, napredak u 
RDBMS tehnologiji, objektno orijentisano programiranje, mobilni internet i 
široko prihvatanje GIS-a vode neprekidnom razvoju GIS-a i njegove uloge
Kao dodatak na desktop GIS, GIS softver se može centralizovati u serverima 
za aplikacije i Web serverima i tako njegove mogućnosti mogu postati 
dostupne bilo kom broju korisnika preko mreže 
Odabrani elementi GIS logike mogu se ugraditi u konkretne aplikacije. GIS 
se takođe ubrzano primenjuje u mobilnim uređajima
GIS korisnici u preduzećima se povezuju na centralni GIS server koristeći 
tradicionalni pristup, napredni GIS desktop kao i Web pretraživače, 
namenske aplikacije, mobilne računarske uređaje i digitalne uređaje 
Vizija GIS platforme se širi



Sveobuhvatna GIS platforma
Zahtevi GIS-a utiču na to kako se izgrađuje i koristi 
GIS softver 
GIS se, kao i druge informacione tehnologije (IT) 
mora implementirati na način koji lako omogućava 
aplikacije koje podržavaju modele rada i poslovne 
zahteve svake organizacije
Ovo se postiže generičkom softverskom platformom 
koja daje sveobuhvatnu podršku za kompletan opseg 
elemenata geografskog znanja kao i velikim brojem 
svestranih alata za upravljanje, obradu, analizu i 
prikaz
U ovom kontekstu, o GIS-u se sve više može misliti 
kao o IT infrastrukturi za okupljanje velikih, 
sofisticiranih višekorisničkih sistema 
GIS platforma mora imati sposobnosti da podrži ovaj 
pristup 



Šta GIS platforma koja ispunjava sve
geografske zahteve treba da sadrži

Geografsku bazu podataka za 
smeštanje geografskih objekata i 
upravljanje njima
Mrežu na nivou Web-a za 
distribuirano upravljanje i deljenje 
podataka 
Desktop i server aplikacije za 
Prikupljanje podataka 
Iznalaženje informacija 
Prostornu analiza i geoprocesiranje 
Kartografsku produkciju 
Vizualizaciju i eksploataciju putem 
slika 
Upravljanje GIS podacima 
Modularne softverske komponente 
koje se mogu ugraditi u aplikacije u 
cilju njihovog prilagođavanja 
konkretnim zadacima 
Geografski informacioni servisi za 
višeslojne i centralizovane GIS 
sisteme 


